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O presente manual elaborado pelas bibliotecas da Universidade de Aveiro (UA), é baseado no 
Publication Manual Of The American Psychological Association: The Oficial Guide To APA Style, 7th 
Edition e oferece um conjunto de diretrizes gerais para a realização de citações em texto e referências 
bibliográficas.

O estilo APA (American Psychological Association) é um sistema de citação autor-data aplicado 
na área das Ciências Sociais e Humanas.

Mais informação de apoio:

APA Style
APA Style Blog
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1. INDICAÇÕES GERAIS

A informação que se segue pretende fornecer indicações e dicas importantes para a realização de 
citações em texto e das respetivas referências bibliográficas.

■ A informação presente neste manual segue as indicações do Publication manual of the 
American Psychological Association: the official guide to APA style, 7th edition, não tendo sido 
realizadas adaptações;

■ Ao longo dos exemplos apresentados neste manual, não foi considerada a tradução ou 
adaptação para português dos termos fixos na construção de citações em texto e referências 
bibliográficas (Ex. Master's thesis). Foram por isso aplicados os termos indicados pela APA 7ed. 
Considera-se que os termos fixos podem figurar na língua em que é escrito o documento, 
sendo a tradução uma opção do utilizador.

■ As citações em texto e a lista de referências bibliográficas devem ser elaboradas de forma 
consistente, sendo que as opções tomadas relativas ao estilo a aplicar ou à adaptação do 
mesmo devem ser respeitadas ao longo de todo o documento, de forma a criar uniformidade 
e clareza na estrutura;

■ São vários os programas disponíveis para a gestão de referências bibliográficas que permitem 
ao utilizador a inserção de citações em texto e a criação da lista de referências bibliográficas 
de forma automatizada. Neste manual são apresentados exemplos dos formulários a preencher 
no programa Mendeley para as diferentes tipologias de documentos. Para mais informação 
sobre o Mendeley consulte o ponto 4 deste manual.

2. CITAÇÕES EM TEXTO
A citação em texto no estilo bibliográfico APA 7ed assume a forma autor-data.

Uma citação é uma forma abreviada de fazer referência no texto a conteúdo de outro autor e deve 
conter toda a informação necessária para permitir uma correspondência inequívoca entre si e as 
respetivas referências bibliográficas no final do documento.
Podem considerar-se três formas de realizar as citações:

■ citação direta - transcrição literal do texto do autor;
o breve
o extensa

■ citação indireta - transmissão da ideia por palavras próprias;
■ citação de citação - quando não se tem acesso ao texto original.

Quanto ao formato, as citações no texto podem assumir dois formatos:
■ entre parêntesis
■ em narrativa
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Nas citações entre parêntesis, o nome do autor e a data de publicação aparecem entre parêntesis.
Exemplo: O consumidor tem vindo a alterar os seus padrões de consumo (Dionísio, 2009).

Nas citações em narrativa, o nome do autor é incorporado no texto como parte da frase, seguido 
do ano entre parêntesis.
Exemplo: De acordo com Dionísio (2009) o consumidor tem vindo a alterar os seus padrões de 
consumo.
Nota: Em alguns casos , o autor e a data podem aparecer incorporados no texto. Nesse caso, não 
utilizar parêntesis.
Exemplo: Em 2009, Dionísio observou que o consumidor tem vindo a alterar o seu padrão de 
consumo.

2.1 A regra
Segundo o estilo bibliográfico APA 7ed a citação em texto segue as seguintes regras:

a) O sistema de citação usado é autor-data, sendo que os elementos devem ter a seguinte 
ordem:
o apelido do autor, ano de publicação do documento e, tratando-se de uma citação direta, 

os números das páginas citadas;
o a informação é colocada entre parêntesis curvos.

b) No caso da introdução de mais do que uma citação ao mesmo tempo, cada citação é separada 
por ponto e vírgula e são ordenadas alfabeticamente pelo apelido do autor, sendo que são 
incluídas todas as citações num único parêntesis curvo.

Exemplo:

a) (Silva, 2010, p. 25)

b) (Craik & Lockhart, 1972; Goldfried, 2013; Pacula et al., 2014)

2.2 Autoria na citação
Segundo a APA 7ed as normas para a citação de autores no texto variam segundo o número de autores 
da obra citada;

A informação da autoria pode figurar na citação em texto dentro de parêntesis ou fora dos mesmos. 
Os exemplos que se seguem apresentam as regras para apresentação da autoria na citação em texto 
no formato entre parêntesis e em formato de narrativa:
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Autoria Citação entre parêntesis Citação em narrativa

Um autor (Luna, 2020) Luna (2020)

Dois autores (Salas & D'Aqostino, 2020) Salas and D'Aqostino (2020)

Três ou mais autores (Martin et al., 2020) Martin et al. (2020)

Grupos como autores, com 
abreviatura (instituições, 
organizações, etc.)

Primeira citação (National Institute of Mental 
Health [NIMH], 2020)

National Institute of Mental 
Health (NIMH, 2020)

Citações seguintes (NIMH, 2020) NIMH (2020)

Grupos como autores, sem 
abreviatura

(Stanford University, 2020) Stanford University (2020)

Sem indicação de autoria:
i) A citação em texto é efetuada 
através das primeiras palavras da 
entrada da referência (normalmente 
parte do título da obra) e o ano;

(“Study Finds," 2007) 
(College Bound Senior, 2008)

“Study Finds" (2007) 
College Bound Senior (2008)

ii) Utilizam-se as aspas: para títulos 
de artigos, capítulos ou páginas web;

iii) Utiliza-se o itálico: para títulos de 
revistas, livros, brochuras, relatórios.

Autoria anónima (Anonymous, 1998) (Anonymous, 1998)

Nos casos em que o próprio 
documento refere autor 
desconhecido
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2.3 Citações ambíguas

Autoria Regra Exemplo

Três ou mais 
autores

Se duas referências com três ou mais 
autores se abreviam da mesma 
maneira devem ser citados os 
apelidos dos autores necessários 
para as distinguir

Jones, Smith, Liu, Huang, and Kim 
(2020)

Jones, Smith, Ruiz, Wang, and Stanton 
(2020)

ou

(Jones, Smith, Liu, et al., 2020)

(Jones, Smith, Ruiz, et al., 2020)
Três ou mais 
autores

Quando apenas o apelido do autor 
final é diferente, devem ser citados 
os apelidos de todos os autores

Hasan, Liang, Kahn, and Jones-Miller 
(2015)

Hasan, Liang, Kahn, and Weintraub 
(2015)

Autores com o 
mesmo apelido

Se a lista de referências inclui 
publicações de dois ou mais autores 
com o mesmo apelido, inclua as 
iniciais dos autores com o mesmo 
apelido em todas as citações do 
texto, mesmo se o ano de 
publicação for diferente.

(C. Costa, Santos & Ramalho, 2010; P. J. 
Costa, Heleno & Pinhel, 2010)

ou

C. Costa, Santos and Ramalho (2010) 
and P. J. Costa, Heleno and Pinhel 
(2010)

Autores com o 
mesmo apelido e 
as mesmas 
iniciais

Inclua o nome dos autores com o 
mesmo apelido e iniciais em todas as 
citações do texto, mesmo se o ano 
de publicação for diferente.

(Paul Janet, 1876 & Pierre Janet, 1906)

ou

Paul Janet (1876) and Pierre Janet 
(1906)

Dois ou mais 
trabalhos de 
autores 
diferentes

entrada por ordem 
alfabética do 
apelido do autor

(Apelido do autor A, Ano do 
documento; Apelido do autor B, 
Ano do documento)

ou

Apelido do autor A (Ano do 
documento) and Apelido do autor B 
(Ano do documento)

(Sousa, 2010; Vieira, 2002)

ou

Sousa (2010) and Vieira (2002)
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Autoria Regra Exemplo

Documentos do 
mesmo autor 
com a mesma 
data 

acrescenta-se ao 
ano de publicação 
uma letra (a, b, c, 
etc.)

(Apelido do autor, Ano do 
documentoa, Ano do documentob)

ou

Apelido do autor (Ano do 
documentoa, Ano do documentob)

(Alves, 1984a, 1984b)

ou

Alves (1984a, 1984b)

2.4 Citações indiretas
A reprodução da ideia de outros autores por palavras próprias e diferentes dos mesmos designa-se 
por citação indireta.
O reescrever de uma ideia de um autor por palavras próprias é o tipo de citação mais frequente ao 
longo de um documento e deve ser sempre acompanhada dos devidos créditos ao autor do 
documento consultado.
Segundo a APA 7ed, a transmissão do conhecimento dos autores dos documentos consultados deve 
ser sempre acompanhada da citação ao mesmo, ou seja a referência em texto ao Apelido do autor, 
Ano de publicação e a localização (páginas).
Para aplicação correta das regras genéricas de citação em texto consulte os pontos 2.1, 2.2 e 2.3 deste 
manual.

2.5 Citações diretas
A inclusão da transcrição literal do texto do autor do documento consultado designa-se por citação 
direta, que pode ser utilizada de duas formas: breve e extensa.
Segundo a APA 7ed, são aplicadas as seguintes regras:
Citação direta breve

o Transcrição literal do texto do documento consultado que não exceda as 40 palavras; 
o A transcrição é inserida no próprio texto, entre aspas;
o Deve incluir a indicação da página (p.) ou o intervalo das páginas (pp.).

Citação direta extensa

o A citação direta extensa define a transcrição literal do texto do documento consultado com 
mais de 40 palavras;

o A transcrição é destacada do texto com avanço da margem esquerda (0,5” polegadas = 
1.27cm) para todas as linhas com espaçamento duplo entre linhas;

universidade de aveiro
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o Se forem transcritos dois ou mais parágrafos de texto a primeira linha do 2° parágrafo e 
seguintes é colocada com um avanço de mais 0,5” polegadas (1.27cm);

o Deve incluir a indicação da página (p.) ou o intervalo das páginas (pp.).

Citações 
diretas

Regra Exemplo

breves Texto que estamos a redigir 
“texto transcrito do documento 
consultado” (Apelido do autor, 
Ano, p. xxx ou pp. xxx-xxx).

ou

Texto que estamos a redigir 
Apelido do autor (ano) “texto 
transcrito do documento 
consultado” (p. xxx ou pp. xxx- 
xxx).

(...) "librarians must be willing to expose themselves 
to the discomfort of advocacy, argument, criticism, 
and real change to be in the forefront of this 
movement” (OgBurn, 2009, p.41).

ou

(.) como refere OgBurn (2009) ao debruçar-se 
sobre esta problemática: "librarians must be willing 
to expose themselves to the discomfort of 
advocacy, argument, criticism, and real change to 
be in the forefront of this movement” (p.41).

Extensas Texto que estamos a redigir. 

texto transcrito do documento 
consultado com 40 ou mais 
palavras. (Apelido do autor, 
Ano, p. xxx ou pp. xxx-xxx)

A personalização de serviços ligada ao alojamento 
de revistas é uma solução amplamente usada.

They are focusing on the capabilities and 
possibilities of new models rather than slavishly 
duplicating or simply automating traditional 
models. Aware there are core services 
underpinning both traditional and new model 
publishing activities, publishing programs are 
concentrating on defining that minimum set 
and learning what is required to support it.

At the same time, they seek to identify the 
most promising new kinds of services needed to 
support authors and editors. (Hahn, 2008, p. 16)
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Citações 
diretas

Regra Exemplo

extensas ou

Texto que estamos a redigir
Apelido do autor (ano):

texto transcrito do documento 
consultado com 40 ou mais 
palavras. (p. xxx ou pp. xxx-xxx)

ou

De acordo com Vieira (2002):

O estudo do comportamento do consumidor é 
definido como a investigação das atividades 
diretamente envolvidas em obter, consumir e 
dispor de produtos e serviços, incluindo os 
processos decisórios que antecedem e sucedem 
estas ações. Na verdade é o estudo do processo 
vivido pelos indivíduos ao tomarem decisões de 
empregar seus recursos disponíveis em itens 
relacionados ao consumo. (p. 219)

2.6 Citação de citação
A referência a documentos originais que não foram consultados, mas dos quais se obteve 
informação através da leitura de outros documentos (secundários), designa-se por citação de citação 
e segue a seguinte regra:

Regra Exemplo

indicação do Autor (documento original) e 
da informação que pretende salientar 
precedida da expressão (as cited in 
Apelido, Ano).

(Adams, 2017, as cited in Smith, 2005)

ou

Adams asserts in her book Chicken Little that "without a 
doubt, the chicken came before the egg" (as cited in 
Smith, 2005).

A APA não aconselha a utilização de fontes secundárias, a menos que o trabalho original não esteja 
disponível.

Nota: na lista de referências bibliográficas é incluída apenas a referência da fonte que consultou.
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3. REFERÊNCIAS BIBLIOGRÁFICAS
As referências bibliográficas apresentam os detalhes da publicação, de forma a permitir uma 
identificação inequívoca dos documentos.
Cada referência inclui a informação prevista pelo estilo bibliográfico em uso que permita a identificação e 
localização do documento consultado. Os dados a incluir variam de acordo com o tipo de publicação.

3.1 A regra
Para a realização da lista de referências bibliográficas, segundo a APA 7ed, devem ser seguidas as 
seguintes indicações:

o A lista de referências bibliográficas deve figurar no final do documento que se encontra a 
redigir;

o A lista de referências bibliográficas deve ser organizada por ordem alfabética do Apelido do 
primeiro autor de cada uma das referências;

o Apenas figuram na lista de referências bibliográficas os documentos citados ao longo do texto, 
sendo que todas as entradas de citações no texto devem corresponder a uma referência 
bibliográfica;

o Não deve ser incluída comunicação pessoal, como correspondência, memorandos ou registos 
de comunicação eletrónica informal na lista de referências bibliográficas (exemplo: e-mails, 
mensagens em chats, entrevistas pessoais, etc.);

o A primeira letra do Título e Complemento do título deve ser capitalizada;

o A consistência é importante na elaboração da lista de referências bibliográficas, sendo que a 
informação e o detalhe dos dados de cada uma das referências bibliográficas deve ser 
uniforme.

Exemplo:

Ashwin, P. (2006). Changing higher education: The development of learning and teaching. 
Routledge.

Barlow, D. H. (2014). Clinical handbook of psychological disorders: A step-by-step treatment manual. 
The Guilford Press. http://books.google.pt/books?id=FCTyAgAAQBAJ

Craik, F., & Lockhart, R. (1972). Levels of processing: A framework for memory research. Journal of
Verbal Learning and Verbal Behavior, 11(6), 671-684. https://d0i.0rg/l 0.1016/S0022- 
5371(72)80001-X
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3.2 Autoria nas referências bibliográficas

Autoria Regra Exemplo

1 autor Apelido, Iniciais do autor Barlow, D. H. (2014). Clinicai handbook of 
psychological disorders: A step-by-step treatment 
manual. The Guilford Press.
http://books.google.pt/books?id=FCTyAgAAQB
AJ

2 a 20 
autores

Apelido, Iniciais de todos os 
autores

Indicar todos os autores até 20 
inclusivé. O último autor é precedido 
de &.

Watson, S., Gunasekaran, G., Gedye, M., van Roy, 
Y., Ross, M., Longdin, L., & Brown, L. (2003). Law 
of business organisations (4th ed.). Palatine Press.

21 ou mais 
autores

Apelido, Iniciais do autor 1 até 
Apelido, Iniciais do autor 19, ...
Apelido, Iniciais do último autor

Indicar os primeiros 19 autores, 
inserir reticências e o último autor

Loannidis, N. M., Rothstein, J. H., Pejaver, V., 
Middha, S., McDonnell, S., Baheti, S. Musolf, A., 
Li, Q., Holzinger, E., Karyadi, D., Cannon-Albright, 
L., Teerlink, C, C., Stanford, J. L., Isaacs, W. B., Xu, 
J.,Cooney, K., Lange, E., Schleutker, J., Carpten, J.
D., ... Weiver, S. (2016). Revel: An ensemble 
method for predicting the pathogenicity of rare 
missense variants. American Journal of Human 
Genetics, 99(4) 877-85.
https://doi.org/10.1016/j.ajhg.2016.08.016

Grupos 
como 
autores

(instituições, 
organizações, 
etc.)

Nome do Grupo

Indicar a designação completa do 
nome do grupo na lista das 
referências (não usar a 
sigla/abreviatura)

American Psychological Association. (2010). 
Publication manual of the American 
Psychological Association. APA.

Sem 
indicação 
de autoria

Título do documento Six sites meet for comprehensive anti-gang 
initiative conference. (2006). OJJDP News @ a 
Glance.
https://www.ncjrs.gov/html/ojjdp/news_at_glanc 
e/216684/topstory.html
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3.3. Referências bibliográficas por tipologia de documento
Os elementos que constituem cada uma das referências bibliográficas variam consoante a tipologia 
de documento e o formato do mesmo (impresso ou digital).
Neste manual são consideradas as seguintes tipologias de documentos:

■ Artigo científico
■ Livro
■ Capítulo de livro
■ Comunicação em conferência
■ Dissertação de mestrado e Tese de doutoramento
■ Legislação
■ Site Web
■ Post em blogue

Para cada tipologia indicada nos quadros seguintes, são apresentados:
■ Os elementos que compõem a referência bibliográfica;
■ Um exemplo de apresentação da referência bibliográfica;
■ Os campos a preencher no formulário do Mendeley.

Artigo científico 
eletrónico

Apelido, Inicial do nome. (Ano). Título do artigo. Título da revista, 
volume(número), páginas xx-xx. https://doi.org/xxxx (preferencial) ou 
https://xxxx

Exemplo:
Goldfried, M. R. (2013). What should we expect from psychotherapy? Clinical 
Psychology Review, 33(5), 862-869. https://doi.org/10.1016/j.cpr.2012.09.006

No Mendeley:

Para um artigo científico eletrónico, preencha os seguintes campos:

o Type: Journal Article
o Title: What should we expect from psychotherapy?
o Authors: Goldfried, M. R.
o Journal: Clinical Psychology Review
o Year: 2013
o Volume: 33
o Issue: 5
o Pages: 862-869
o DOI: https://doi.org/10.1016/j.cpr.2012.09.006
o URL: http://www.ncbi.nlm.nih.gov/pubmed/23628909
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Livro eletrónico

Capítulo de livro 
eletrónico

Apelido, Inicial do nome. (Ano). Título do livro. (número da edição). Editor
comercial. https://doi.org/xxxx (preferencial) ou https://xxxx

Exemplo:
Antonelli, G. (2006). Underwater robots: Motion and force control of vehicle-
manipulator systems (2nd ed.). Springer. https://doi.org/10.1007/11540199

No Mendeley:

Para um livro eletrónico, preencha os seguintes campos:

o Type: Book
o Title: Underwater robots: Motion and force control of vehicle- 

manipulator systems
o Authors: Gianluca Antonelli
o Year: 2006
o Edition: 2
o Publisher: Springer
o DOI: https://doi.org/10.1007/11540199
o U RL: http://link.springer.com/10.1007/11540199

Apelido, Inicial do nome do autor do capítulo. (Ano). Título do capítulo do 
livro. In Inicial do Nome. Apedido do editor literário do livro (Ed. ou Eds.), 
Título do livro (pp. xx-xx). Nome do editor comercial. https://doi.org/xxxx ou 
https://xxxx

Exemplo:
Rhodes, R. A. W. (2007). Blair and governance. In R. Koch & J. Dixon (Eds.), 
Public governance and leadership (pp. 95-116). DUV.
https://doi.org/10.1007/978-3-8350-9100-9 5

No Mendeley:

Para um capítulo de livro eletrónico, preencha os seguintes campos:

o Type: Book section
o Title: Blair and governance
o Authors: R. A. W. Rhodes
o Book: Public governance and leadership
o Year: 2007
o Edition:
o Publisher: DUV
o Pages: 95-116
o Editors: R. Koch, J. Dixon (um editor por linha)
o DOI: https://doi.org/10.1007/978-3-8350-9100-9 5
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Comunicação 
eletrónica em 
conferência

Para uma comunicação publicada em formato de artigo científico, livro ou 
capítulo de livro eletrónico, deve seguir as indicações mencionadas neste 
tutorial para a respetiva tipologia de documento.

Sessão / Comunicação / Poster em conferência

Apelido, Inicial do nome do autor. (Ano, Mês Dia-Mês Dia). Título da 
comunicação [Conference session ou Paper presentation ou Poster 
presentation]. Nome da conferência, Local. https://doi.org/xxxx ou 
https://xxxx.

Exemplo:
Rutledge, L., LeMire, S., & Mowdood, A. (2015, March 25-28*).  Dare to 
perform: Using organizational competencies to manage job performance*  
[Paper presentation]. Association of College & Research Libraries 2015 
Annual Conference, Portland, OR, United States*.
http://www.ala.org/acrl/sites/ala.org.acrl/files/content/conferences/confsand  
preconfs/2015/Rutledge_LeMire_Mowdood.pdf

No Mendeley:

Para sessão / comunicação / poster em conferência online, preencha os 
seguintes campos:

o Type: Conference Proceedings
o Title: Dare to perform: Using organizational competencies to 

manage job performance [Paper presentation]
o Authors: Rutledge, L., LeMire, S., & Mowdood, A. (um autor por 

linha)
o Proc. Title: Association of College & Research Libraries 2015 Annual 

Conference, Portland, OR, United States.
o Year: 2015
o URL:

http://www.ala.org/acrl/sites/ala.org.acrl/files/content/conferences/c  
onfsandpreconfs/2015/Rutledge LeMire Mowdood.pdf

*Nota: Ao finalizar o documento word, após quebrar as ligações ao 
Mendeley, é necessário corrigir três elementos na referência bibliográfica:

- no parêntesis do ano, é necessário colocar o mês e o dia. Exemplo: (2016, 
March 30-April 2) ou (2019, May 20-22)
- colocar itálico no título da Sessão / Comunicação / Poster
- retirar o itálico do Nome da conferência, Local.
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Publicadas em bases de dados ou disponíveis em repositórios

Apelido, Inicial do nome do autor. (Ano). Título da dissertação de mestrado
ou tese de doutoramento [Master's thesis ou Doctoral dissertation, Nome da
Instituição]. Nome da base de dados ou repositório. http://xxx

Exemplo:
No Mendeley, é 
necessário efetuar a 
seguinte ativação:

Menu Tools >
Options,

Almeida, A. C. P. de. (2019). Implementação de uma academia de 
conhecimento em contexto industrial: Uma proposta metodológica [Master's 
thesis, Universidade de Aveiro]*.  Repositório Institucional da Universidade de 
Aveiro. https://ria.ua.pt/handle/10773/26809

Document type:
Thesis

ativar os campos: 
“Genre“ e 
”Publisher” > Apply > 
Ok.

Legislação

No Mendeley, é 
necessário efetuar a 
seguinte ativação:

Menu Tools >
Options,

No Mendeley:

Para uma dissertação de mestrado ou tese de doutoramento eletrónica,
preencha os seguintes campos:

o Type: Thesis
o Title: Implementação de uma academia de conhecimento em 

contexto industrial: Uma proposta metodológica
o Authors: Almeida, A. C. P. de.
o Year: 2019
o Genre: Master's thesis, Universidade de Aveiro
o Publisher: Repositório Institucional da Universidade de Aveiro 
o URL: https://ria.ua.pt/handle/10773/26809

*Nota: Ao finalizar o documento word, após quebrar as ligações ao 
Mendeley, é necessário corrigir a referência, alterando a posição do 
parêntesis reto conforme o exemplo apresentado.

Uma vez que o estilo bibliográfico APA 7th não menciona como proceder
para legislação de outros países que não os EUA, o que apresentamos de
seguida é apenas uma sugestão para:

Lei / Decreto-lei / Despacho/Portaria

Exemplo:

Despacho n.° 17169/2011 do Ministério da Educação e Ciência.*  (2011).
Document type:
Statute

Diário da República: II série, n.° 245. https://dre.pt/application/file/1010956

ativar o campo 
”Publication” > Apply 
> Ok.

universidade de aveiro
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No Mendeley:

Para uma Lei, Decreto-lei, Despacho ou Portaria, preencha os seguintes 
campos:

o Type: Statute
o Title: Despacho n.< sup>o< /sup> 17169/2011 do Ministério da 

Educação e Ciência
o Publication: Diário da República: II série, n.° 245
o Year: 2011
o URL - https://dre.pt/application/file/1010956

*Nota: ao finalizar o documento word, após quebrar as ligações ao 
Mendeley, é necessário corrigir a referência, retirando a vírgula e colocando 
um ponto, conforme o exemplo apresentado.

O código de HTML no campo Title serve para formatar o caractere 
sobrescrito do título - n.< sup>o< /sup> = n.°

Site web

No Mendeley, é 
necessário efetuar a 
seguinte ativação:

Menu Tools >
Options:

Document type:
Web Page

ativar o campo “Day” 
e “Month” > Apply > 
Ok
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Apelido, Inicial do nome do autor ou nome da instituição/organização. (Ano, 
Mês dia). Título do documento. Nome do site* *. https://xxxx

* Omitir este elemento quando o autor e o nome do site (Publication) 
tiverem o mesmo nome.

Exemplo de página web com autoria de uma instituição/organização:
Universidade de Aveiro. (2020). Apoio ao ensino. https://www.ua.pt/pt/apoio- 
ensino

Exemplo de página web com autoria individual:
Giovanetti, F. (2019, November 16). Why we are so obsessed with personality 
types. Medium. https://medium.com/the-business-of-wellness/why-we-are- 
so-obsessed-with-personality-types-577450f9aee9

No Mendeley:

Para uma página Web, preencha os seguintes campos:

o Type: Web Page
o Authors: Giovanetti, F.
o Title: Why we are so obsessed with personality types
o Year: 2019
o Publication: Medium
o Day: 16
o Month: November
o U RL: https://medium.com/the-business-of-wellness/why-we-are-so- 

obsessed-with-personality-types-577450f9aee9

https://dre.pt/application/file/1010956
https://xxxx/
https://www.ua.pt/pt/apoio-ensino
https://www.ua.pt/pt/apoio-ensino
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Post em blogue Apelido, Inicial do nome do autor. (Ano, Mês Dia). Título do post. Nome do 
blogue. http://xxxx

No Mendeley, é 
necessário efetuar a 
seguinte ativação:

Exemplo:
McAdoo, T. (2019, November 7). How many names to include in an APA 
Style reference. APA Style. https://apastyle.apa.org/blog/more-than-20- 
authors

Menu Tools >
Options, No Mendeley:
Document type: Para um post em blogue, preencha os seguintes campos:
Journal Article

o Type: Journal Article
ativar o campo "Day” 
e "Month” > Apply > 
Ok.

o Title: How many names to include in an APA Style reference 
o Authors: McAdoo
o Journal: APA Style
o Year: 2019
o Day: 7
o Month: 11

URL: https://apastyle.apa.org/blog/more-than-20-authors
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3.3.2 Em formato impresso

Artigo científico

Livro

Apelido, Inicial do nome. (Ano). Título do artigo. Título da revista, 
volume(número), páginas xx-xx.

Exemplo:
Goldfried, M. R. (2013). What should we expect from psychotherapy? Clinical 
Psychology Review, 33(5), 862-869.

No Mendeley:

Para um artigo científico, preencha os seguintes campos:

o Type: Journal Article
o Title: What should we expect from psychotherapy?
o Authors: Goldfried, M. R.
o Journal: Clinical Psychology Review
o Year: 2013
o Volume: 33
o Issue: 5
o Pages: 862-869

Apelido, Inicial do nome. (Ano). Título do livro. (número da edição). Editor.

Exemplo:
Antonelli, G. (2006). Underwater robots: Motion and force control of vehicle- 
manipulator systems (2nd ed.). Springer.

No Mendeley:

Para um livro, preencha os seguintes campos:

o Type: Book
o Title: Underwater robots: Motion and force control of vehicle- 

manipulator systems
o Authors: Antonelli, Gianluca
o Year: 2006
o Edition: 2
o Publisher: Springer
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Capítulo de livro Apelido, Inicial do nome do autor do capítulo. (Ano). Título do capítulo do 
livro. In Inicial do Nome. Apedido do editor literário do livro (Ed. ou Eds.), 
Título do livro (pp. xx-xx). Nome do editor comercial.

Exemplo:
Canon, C. L. (2006). Gastrointestinal tract. In J. K. Lee, S. S. Sagel, R. J. Stanley, 
& Jay P. Heiken (Eds.), Computed body tomography with MRI correlation (4th 
ed., pp. 771-828). Lippincot Williams & Wilkins.

No Mendeley:

Para um capítulo de livro, preencha os seguintes campos:

o Type: Book section
o Title: Gastrointestinal tract
o Authors: C. L. Canon
o Book: Computed body tomography with MRI correlation
o Year: 2007
o Edition: 4
o Publisher: Lippincot Williams & Wilkins
o Pages: 771-821
o Editors: J. K. Lee, S. S. Sagel, R. J. Stanley, Jay P. Heiken (um editor 

por linha)

Comunicação em 
conferência

Para uma comunicação publicada em formato de artigo científico, livro ou 
capítulo de livro, deve seguir as indicações mencionadas neste tutorial para 
a respetiva tipologia de documento.

Sessão / Comunicação / Poster em conferência

Apelido, Inicial do nome do autor. (Ano, Mês Dia-Mês Dia). Título da 
comunicação [Conference session ou Paper presentation ou Poster 
presentation]. Nome da conferência, Local.

Exemplo:
Maddox, S., Hurling, J., Stewart, E., & Edwards, A. (2016, March 30-April 2* ). If 
mama ain't happy, nobody's happy: The effect of parental depression on mood 
dysregulation in children* [Paper presentation]. Southeastern Psychological 
Association 62nd Annual Meeting, New Orleans, LA, United States*.

universidade de aveiro
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No Mendeley:

Para sessão / comunicação / poster em conferência, preencha os seguintes 
campos:

o Type: Conference Proceedings
o Title: If mama ain't happy, nobody's happy: The effect of parental 

depression on mood dysregulation in children [Paper presentation]
o Authors: Maddox, S., Hurling, J., Stewart, E., & Edwards, A. (um autor 

por linha)
o Proc. Title: Southeastern Psychological Association 62nd Annual 

Meeting, New Orleans, LA, United States
o Year: 2016

*Nota: Ao finalizar o documento word, após quebrar as ligações ao 
Mendeley, é necessário corrigir três elementos na referência bibliográfica:

- no parêntesis do ano, é necessário colocar o mês e o dia. Exemplo: (2016, 
March 30-April 2) ou (2019, May 20-22)
- colocar itálico no título da Sessão / Comunicação / Poster
- retirar o itálico do Nome da conferência, Local.

Dissertação de 
mestrado e tese 
de doutoramento

Apelido, Inicial do nome do autor. (Ano). Título da dissertação de mestrado 
ou tese de doutoramento [Unpublished master's thesis ou Unpublished 
doctoral dissertation]. Nome da Instituição que concedeu o grau.

Exemplo:
Almeida, J. M. G. (1999). Ecologia fisiológica da população de leveduras numa 
salina solar [Unpublished doctoral dissertation]. Universidade de Aveiro.

No Mendeley:

Para uma dissertação de mestrado ou tese de doutoramento, preencha os 
seguintes campos:

o Type: Thesis
o Title: Ecologia fisiológica da população de leveduras numa salina 

solar
o Authors: Almeida, J. M. G.
o Year: 1999
o Genre: Unpublished doctoral dissertation

University: Universidade de Aveiro
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4. GESTOR DE REFERÊNCIAS BIBLIOGRÁFICAS: MENDELEY
O Mendeley é um software que disponibiliza uma versão livre para Windows e Macintosh.

A versão livre deste programa disponibiliza uma interface web e outra desktop, que são de uso 
amigável e intuitivo. Para mais informação sobre citações e referências bibliográficas e sobre este 
gestor automático de referências, consulte:

Guia temático gestão de referências bibliográficas: o bom uso da informação
Instalação do Mendeley
FAQs do Mendeley
Mendeley Help Guides

4.1 Citações em texto
Inserção de citações em texto:

■ No Word coloque o cursor no local do texto onde pretende inserir a citação;

■ No menu superior References selecione a opção Insert Citation presente no bloco Mendeley 
Cite-O-Matic;

Se o bloco Mendeley Cite-O-Matic não se encontrar visível, encerre todos os programas do 
Office e, no menu superior Tools do Mendeley Desktop, selecione a opção Install MS Word 
Plugin, na janela clique em OK.

■ Nesta janela tem duas opções para inserir uma citação em texto:
o execute pesquisa nessa janela, selecione a referência que quer citar e clique em OK;

ou
o clique no botão Go to Mendeley presente nessa janela, selecione a referência e no menu 

superior do Mendeley Desktop selecione a opção Cite.

■ No menu superior References selecione o estilo American Psychological Association 7th edition 
no campo Style presente no bloco Mendeley Cite-O-Matic;

Caso o estilo American Psychological Association 7th edition não se encontre presente na lista, 
selecione a opção More Styles... e, na janela, clique no segundo separador Get More Styles. 
Execute pesquisa por American Psychological Association 7th edition, selecione o estilo e 
depois clique em Install. De seguida, clique no separador Installed, selecione novamente o 
estilo, clique em Use this Style e por fim clique em Done. No documento Word, clique em 
Refresh do bloco Mendeley Cite-o-Matic para que o estilo apareça na janela dos favoritos e o 
possa aplicar ao documento.
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Inserção de múltiplas citações em texto:
Caso pretenda inserir várias citações em simultâneo (para casos em que vários autores atestem a 
mesma informação), deverá seguiros procedimentos indicados acima, inserindo as várias citações, de 
seguida selecione-as e clique em Merge Citations.

Edição de citações, após a inserção no Word:
■ Coloque o cursor na citação que pretende editar e selecione no menu References do Word, a 

opção Edit Citation presente no bloco Mendeley Cite-O-Matic;

■ Na janela, coloque o cursor no Nome do autor Ano (ex.: Silva 2010) para expandir a janela e 
ver as opções disponíveis;

■ Na janela de edição de citações pode acrescentar ou suprimir informação presente na 
citação, nomeadamente:

o Page - introduza o número ou intervalo de número de páginas (ex.: 8 ou 16-34);
o Prefix - a utilizar em caso de citações de citações (as cited in);
o Supress autor - coloque um visto nesta opção para suprimir a informação da autoria 

da citação (parêntesis), nos casos em que refere o autor no seu texto (ex: Segundo 
Vieira (2020).

4.2 Referências bibliográficas
Ativação da lista de referências bibliográficas no Word

■ Com o Mendeley, a lista de referências bibliográficas não é apresentada automaticamente 
com a inserção de citações em texto;

■ A inserção da lista de referências bibliográficas tem de ser ativada pelo utilizador, sendo que 
após a ativação, a mesma será atualizada à medida que forem sendo inseridas citações em 
texto;

■ Para ativar a lista de referências bibliográficas, posicione o cursor no local onde pretende 
inserir a lista, selecione no Word o separador References, e no bloco Mendeley Cite-O-Matic a 
clique na opção Insert bibliography.
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Seleção do estilo bibliográfico APA 7ed no Mendeley

■ No Mendeley desktop, selecione o menu View> Citation style> American Psychological 
Association 7ed edition;

■ No Word, deve ser verificado se o estilo American Psychological Association 7ed edition se 
encontra selecionado no campo Style, presente no bloco Mendeley Cite-O-Matic, do 
separador References do Word. Caso não esteja visível na lista de estilos, siga as indicações 
apresentadas no ponto 4.1 deste manual.

Edição de referências bibliográficas no Mendeley
■ A edição e alteração dos vários elementos (campos) que compõem uma referência 

bibliográfica deve ser realizada apenas através do Mendeley. As alterações que efetuar 
diretamente no Word não serão assumidas enquanto o documento tiver ligações ao 
Mendeley;

■ Ao selecionar um registo no Mendeley desktop, pode efetuar alterações na referência 
selecionada através da barra lateral direita. Para refletir estas alterações no seu documento 
word, deve clicar em Refresh, presente no bloco Mendeley Cite-O-Matic, do separador 
References do Word.

Nota:

■ Para algumas tipologias de documento, os campos definidos pelo Mendeley não prevêm 
todos os elementos do estilo em uso. Nestes casos, as alterações às referências 
bibliográficas passam pela quebra de ligação ao Mendeley e pela posterior edição manual;

■ Este processo só deve ser efetuado quando o documento que se encontra a redigir estiver 
finalizado;

■ No document Word, separador References, bloco Mendeley Cite-O-Matic, selecione a opção 
Export> Without Mendeley Fields;

■ Guarde esta versão do documento com outro nome e efetue as alterações necessárias 
nesta versão do documento.

Ativação de campos de descrição bibliográfica
■ Se o formulário do Mendeley não incluir um dos campos obrigatórios numa determinada 

tipologia de documento, pode proceder à ativação dos mesmos;

■ Selecione o menu Tools> options> Document Details, selecione o Document type pretendido 
e coloque um visto nas caixas de seleção dos campos da lista, clique em Apply e depois em 
OK;

■ Preencha os campos ativados na barra lateral direita do registo selecionado.
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5. TUTORIAIS | MANUAIS
A nova edição do Publication manual of the American Psychological Association: the official guide to 
APA style, 7th edition está disponível na versão impressa no fundo documental das bibliotecas da UA.

Consulte mais informação de apoio:
APA Style
APA Style Blog
Style and Grammar Guidelines
Instructional Aids
Pordue Online Writing Lab
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American Psychological Association. (2020). Publication manual of the American psychological 
association: The official guide to APA style (7th ed.). APA.
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